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APA 7th
File Edit Tools Window Help

Size
~ . h
. Punctuation File Name: APA 7t
- Anonymous Works Full Name:- APA 7th
.. Page Mumbers
.. Journal Names Based on: |Pub||'cation Manual of the American Psychological Association (APA) 7th edition
.- Sections R
: Psychology, Multi-disciplinar
& Citations Category: | Y ay, plinary
- Templates Publisher: |Ame|’|‘can Psychological Association (APA)
- Ambiguous Citations
- Author Lists URL: |httpsrffapastvle‘apa-orgf
- Author Name Created: 20205105280, T4 03:39:41
- Mumbering
- Sort Order Las
-Bibliography ot
- Templates —1 I—
- Field Substitutions Tk edition. ~
- Layout Tt S s f
vare of.
- Sort Order 2 E g At —
| Z I
- Categories = = (=) ER
. Authar Lists Lif using
- Author Mame .
- Editor Lists th indle
.. Editor Mame b¢
- Title Capitalization
- Footnotes )
- Templates Web Page referencg Itvpe. | o
- Field Substitutions For references requiring a Year and Date, enter the corresponding date for the Year field in the Last Update
~ Repeated Citations Date field using the format Month, Year. Enter the full Retrieval date into the Access Date field using the format

- Author Lists

- Author Mame

- Editor Lists

- Editor Mame

- Title Capitalization

Month Day, Year.

Retrieval dates:
The retrieval date is now only needed for sources that are designed to change or reflect information that

- Figures & Tables
. Figures changes over time (i.e., social media sites), or for sources that are not archived. (Please see section 9.16 of the

.. Tables
- Separation & Punctuation W

manual for specific information.) The retrieval date will print if it is present in the library reference. You may

nead ta mannalhs adit vanr final mannierrint tn add Aar remnve the retrieval date infarmatinn

o - 41
BlEaM® EEEMERAT



BIEUE | HITISEY

JL
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EEEIG\%IEE%%‘[&%}%EDE

Journal Name Format

‘@ Use full journal name

(") Abbreviation 1

1 Abbreviation 2

(") Abbreviation 3

() Don't replace

2 Clarivate”
BlaEgR”

Citation

1 F 3 N e
EE /i A AE

B IRFARTOR ~ WIFE

IR IR RAE ST

WUGEE BHEH

HEENERAT
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- About this Style
. Punctuation

- Anonymaous Works

- Journal Mames

i Sections

T T AUOT LSS
Author Name
Numbering
Sort Order

= Bibliography
Templates
Field Substitutions
Layout
Sort Order
Categories
Author Lists
Author Name
Editor Lists
Editor Name

Title Capitalization Egiﬁ, #ER & STC (2005) AREENAERE  tNHEEEEEMESE. FEHEAE x451), 56-8,

[=- Footnotes
Templates
Field Substitutions
Repeated Citations
Author Lists
Author Name
Editor Lists

C. Page Numbers BB1EX B & ¢

Page Mumber Format
(™) Don't change page numbers N EEFEHERIANBEBE R

(") Show only the first page number (e.g. 123) X 28~ EIEE W ES
") Abbreviate the last page number {e.g. 123-5)

") Abbreviate the last page, keeping two digits (e.g. 123-25)

() Show only the first page for journals, ful range for others
HEHTINERBRERR - EtM R R B R T EN

BNEERZ B - MR B S BREUSLSMERZERN S -
N - REE A B N5 5R56-58 -

4

Editor Name RERE REH & ETC. (2000) RREEMNIERE  tNEEEEEEWESE. FFHEAE x451), 156-58,

Title Capitalization
- Figures & Tables
Figures
Tables
Separation & Punctuation

2 Clarivate”
BlaEgR”

BNEERZ B - MREFREEMBER - HEHEREHERISES -
i RE A ENE4156-158 -
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D. Journal Names HATIZIE R € @ ¢

T T AUOT LS

- About this Style
Punctuation
Ant:un'_-,.fmcnus Works
----- Page Numbers

Sections

Author Name
Numbering

Sort Order

= Bibliography
Templates

Field Substitutions
Layout

Sort Order
Categories
Author Lists
Author Name
Editor Lists

Editor Name

Title Capitalization

[=- Footnotes

Templates

Field Substitutions
Repeated Citations
Author Lists

Author Name
Editor Lists

Editor Name

Title Capitalization
- Figures & Tables
Figures

Tables

Separation & Punctuation

2 Clarivate”
Blagse”

Journal Mame Format

@ Use full journal name; 155 FHHA T =72 L

() Abbreviation 1
() Abbreviation 2
(") Abbreviation 3
) Don't replace

AR ETE - —1ERS
LN R ER

> [Library]>[Open Term
Lists]>[Journals Term List]

ZZEH P2

ERATMERE =
E fEfa s T

ERIREZ

r-* NCB [ RH"DUI’I es ¥ How To ¥

Pljbmedgav

US Mational Library of Medicine
National Institutes of Health

PubMed hd |gene

EJRSS Save search Advanced

Show additional filters

Article types
Clinical Trial
Review

More ...

Text availability
Abstract

Reader comments

Publication dates
5 years
10 years

Display Settings: [~ Summary, 20 per page, Sorted by Recently Added Send to:

Results: 1 to 20 of 1972322 Selected: 2 Page of 88617  Mext> Last==

[ Role of T!.fpe I Pili in Predation by Bdellovibrio bacteriovorus.

PLoS One. 2014 Nov 13:9(11):e113404. oi: 10.1371fjournal pone.0113404. eCollection 2014.

SIILE A4 0US 35 IPUDVed - 35 supplied by publishe

reamanian A, Stevens T, Helmke KJ, Zepeda W, Qi LS, Lim WA,

ACS Symh Biol. 2014 Nov 19 [Epub ahead of prinf]

45 supplied by publisher]
M
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D.1 Journals Term List {Sci8fHR ¥ ER

Library Tools Window Help ?Eﬁﬁﬂﬁl}':ju End Note Libra ry - tll]ﬁ
Sync Z{EEndNote Library’R 53 BI#1T
Advanced Search EA é‘F—ﬁB H«( EA__

Sort Library...

Find Duplicates [Library]>[Open Term Lists] >[Journals Term List]

Find Broken Attachment Links

Open Term Lists * Authors Term List
Define Term Lists... Ctri+4 Journals Term List
Link Term Lists... Ctrl+3 Keywords Term List B
FOOTTTOT
Spell Check Ctrl+Y
Find and Replace.. CHrl term Lists %
Change/Move/Copy Fields... Terms | Lists
Recover le[ar}l‘ 101 Journals in the Journals List:
B Full Journal Abbreviation 1 Abbreviation 2 Abbreviation3 A
lefaff Summaﬁ" J Agric Food Chem
J Allergy Clin Immunol i i
.
:
J Econ Entomol
J Food Sci Insert Term
J Food Sci Technol
JACC Cardiovasc Imaging JACC. Cardiovascular imaging

Journal of Apicultural Research
Journal of Artificial Intelligence...
Journal of Computer Assisted ... v

Hint: Hold the Ctrl key to select multiple terms
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D.1 Journals Term List {SEXEAFIREBBR

B) 2 2 A BT (Ctrl+A) > Delete Term

Term Lists o

Terms Ljsts

101 Journals in the Journals List:

Full Journal Abbreviation 1 Abbreviation 2 Abbreviation3 4
2013 leee 13th International C... New Term...
American Nineteenth Century .. Am. Ninet. Century Hist. .

. Edit Term...
Anal Bioanal Chem

Appl Environ Microbiol Delete Term
Arthritis Res Ther Arthritis research & therapy

Artificial Intelligence Insert Term

Beijing Da Xue Xue Bao Beijing da xue xue bao. Yi xue ..

Biomed Res Int
BMC Genomics
Chest

Clinical Neurophysiology v

Hint: Hold the Ctrl key to select multiple terms

Close

2 Clarivate”
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D.1 Journals Term List {SEqHATI B E BB

EListsB#E = Journals>[Import List...] s

N DE AR SR I HE T &

H

Z\\\

7J
[ ]

=

Term Lists X
< BARK x
Terms Lists 4 « EndNote ... » Terms Lists v | D O = Terms Lists
‘EndNote Sample.enl &2 | Create List... AaEE . LN s - |
; a A Pedi A
Authors Blename ek . A BB BB ~ .
Journals s RETH =| Astronomy and Astrophysics.txt 20117972 atria
Keywords Delete List... @ OneDrive BioScience.bt 2012/10/ Pediat
Chemical.txt 2018/5/20 | iy
EFR: Economics.txt 2011/92. (Rio)
B EDLL Humanities.txt 2011/9/2
3 FE Karean Medical Terms.txt 2012/10/ Pediat
L. ] rira
Delimiters Update List... g vt ey (Rio)
\ / Py Medical.txt 2017/10/
, : . T - ;; Philo-sophy.bct 2012/10/ A'M'A'
Custom Delimiter: | = Physics.txt 2012/10/ fmeric
_ . o Export List... = EBR Religion.txt 2006/10/ & &0
Carriage return is always used as a term delimiter. Wepe v < > ..Iou{na ™
Link Lists...
EEEBN): | Medical txt v Textfile (“txt) v

Term Lists

Terms Lists

14164 Journals in the Journals

Full Journal
A Pediatria
AM.A, American Journ...
AM.A. Archives of Der...
AM.A. Archives of Der...
AM.A Archives of Gen...

2019 JCR

Term list

AM.A, Archives of Otol...

AM.A. Archives of Indu...
AM.A, Archives of Indu.. Al
AM.A. Archives of Inter...
AM.A, Archives of Neur...
AM.A Archives of Neur...
AM.A. Archives of Opht...

Abbreviation 1 ~

Pediatria (Rio)
AMA Am. J. Dis. Child.
AMA Arch. Derm. Syph...
AMA Arch. Derm.

AMA Arch. Gen. Psychi...
AMA Arch. Ind. Health

Abbreviation 2
Pediatria (Rio)
AMA Am J Dis Child
AMA Arch Derm Syphi...
AMA Arch Derm

AMA Arch Gen Psychia...
AMA Arch Ind Health
AMA Arch Ind Hyg Oc...

Abbreviation 3

AM.A. Archives of Der...

“‘
AMA, Archives.of Ind...

AMA Arch. Neurol.
AMA Arch. Ophthalmol.
AMA Arch. Otolaryngol.

2 Clarivate”
BlEgR"

Hint: Hold the Ctrl key to select multiple terms

B EzTermsE & B0 T & 2R INE ARV T i85
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E. Section 2EXRE

- About this Styl
: au ff' tyle These options allow you to areate multiple bibliographies in a single Microsoft Word
- Punctuation document when using Cite While You Write (CWYW). According to the type of style you are
- Ananymous Works | working with, choose how dtations should appear for each section and document.
... Page Mumbers )
sections
- Journal Mames

Author Name
2;‘,’,“3,’:;‘? (") Create a bibliography for each section 7 X =87V KA1/ Z T EL
= Bibliography

Templates . - . g . .
S i Continue numbering, or apply settings for disambiguation and repeated

Layout dtations across sections
Sort Order

Catagories —. Create a bibliography for each section and a complete bibliography at the

Author Lists

Author Neme ~ end of the document 7 2 37 12 2= 5 30 51) £ 3 ST ik

Editor Lists
Editor Name Mumbering will continue, and settings for disambiguation and repeated
Title Capitalization citations will be applied across sections.

[=- Footnotes
Templates
Field Substitutions

T FIRRWord X & EH 7
ooy BiRATE - ULTHAEA EEE -
Editor Name
Title Capitalization
= Figures & Tables
Figures
Tables
Separation & Punctuation
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F.1 Citation - Templates IEXHFMSIX/GI5E R .dh . € . ¢
— #fI—

srommeus i (AHABER) AUERIEH (DX
Journal Names Citation
[:ism (Author,[Year|:p."pp.Cited-Pages|) ;;:;g-ﬁmﬁﬂ '8 BUTREZRERHN R
. Citation - Author (Year)
- Ambiguous Citations| Author(|Year|,-p.” pp.-Cited-Pages|) ‘(f‘ﬁ:@mﬁa
Authﬂr Lists (’QK} (:‘ 2 s:ﬁ'n )
- Author Mame (M) (Mm% #1999 :350)
. L 7))
- Numbering ‘ Argyris & Schon, 1978: 20-26
o Sart Order =§( Lusldr:g,éooo; Riker, 1980 )
Field Substitutions - (Z) XCEFEE
Layout Citation (48] fE8 (ER: AM)
Sort Order : (%61) WM - R\ (1999 : 350)
Caisocrioe (Author,|Year|:-Cited-Pages|) ArgyrisBiSchoni®® ( 1978: 20-26)
i Fisher ( 1978, 1985, 1999 )
i () FERSETAR  E—RFACESHE B RUSEREE—0EEDN
S Citation - Author (Year) etal. (S1) ; EEBAALLE - SX@HIE—QEERM et al. (FA) -
v . -
Editor Name Author-(|Year|:-Cited-Pages|) -

: SR == i) = o
| =IRechhelenm) SIHEW  AREZE=p(pp) - BEMIHEER
(= Footnotes

Templates
Field Substitutions ‘
Repeated Citations
Author Lists
Author Name
Editor Lists (Brugha, 2015: 734)«
Editor Name
Title Capitalization +
2 F-gurgs&'l’ables
i, g Brugha, C. M. (2015). Foundation of Nomology. European Journal of Operational
PP Ractan Research, 240(3), 734-747. doi: 10.1016/j.ejor.2014.07.042+
C Clarivate”
= 52
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Mac R F1ENINBEIUE

® EndNote20 File

Edit References Groups Library

Tools Window Help

LE

@

Anonymous Works
Plain Font 3oL
Bold #B
Italic 3|
Underline #U
Small Caps
Copy Style N#C
Paste Style #V
Superscript ~3E+
Subscript ~3E-

C Clarivate”

Magr"

Undo b Z
Redo 36z
Cut #EX
Copy #&C
Paste #EV
Paste With Text Styles

Select All FEA
Spelling B
Change Case >
Font >
Start Dictation... fn fn

Emoji & Symbols ~3Space

Personal Communication

5| APA 6th.ens

itle. [Translated Title]. [Re

itle| (|Translator, Trans. | E

sher| .
Sentence case. ~¥C
lowercase
UPPERCASE
Capitalize Each Word
tOGGLE cASE

€
EEHEMERATE
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F.1 Citation - Templates IEX9$A5|3Z/5]5

About this Style
Punctuation
Anonymous Works
Page Numbers
Journal Names
Sections

- Citations

-- Templates

- Ambiguous Citations
. Author Lists

- Author Mame

- Mumbering

- Sort Order

Field Substitutions

Layout

Sort Order

Categories

Author Lists

Author Name

Editor Lists

Editor Name

Title Capitalization
[=- Footnotes

Templates

Field Substitutions

Repeated Citations

Author Lists

Author Name

Editor Lists

Editor Name

Title Capitalization
= Figures & Tables

Figures

Tables

Separation & Punctuation

2 Clarivate”
BlaEgR"

(AHTHEBR) @mAEREM (PX)

FEERA—RER ) E201453F (FRHB465) £ SIFREZRERA &
RBEFE -

- XESIA

(—) XSS |BAE
() (FE £ ®BN)
(@A) (EE%E - |38 1999:350)
(@& 2, 1997)
( Argyris & Schon, 1978: 20-26 )
( Luskin, 2000; Riker, 1980 )
(Z) XPERNFEERRRE
[4&8X) E& (£ : BY)
(Ef) BEE - |FE| 1999 :350)
ArgyrisZSchorzé® ( 1978: 20-26)
Fisher ( 1978, }985, 1999)
(=) FEE=ZERARE  B1RHABEEEHILE  B_RUGEEREE—UEEEM
etal. (BA) | FEEFALULE SRXEFE—MAEEUMetal. (BA)

ZES| NN PRETIR
Multiple citation separator: I;

Year Format
Use 2-digit years ('99)
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F.2 Ambiguous Citations

BERBARSIXEIER -

(Author, Year) ) ¢

mﬁ“w To Differentiate Ambiguous Citations:
N tion
Ano Works . . .
p,gm“::smo Include the author initials or full name in citation MES|IXEERNHARER - BINEFEN
JoumalNares P (RB/EB/E—ATS)  LURES
Cfﬁ«:m Mame format: |A. BE. - | ( /HRR/5 )
- tatons
- Templates ] o _ imﬂﬂé_,%_ «E%Eggi ’ E@JE_”/XE
. Ambiguous Citations | Add more authors until the dtation is unique Bl REZ|T
- Authar Name | Add the title for different works by the same author [5] —{EZ& [ — FCRIAESCEL - PUE]
~Numbering title(Z5&/short title) - LURE A
. Sort Order Title format: |Fu|| Tite 'r| ( / )
Field Substitutions
Layout
Sort Order Add a letter after the year _ . . _ ‘ .
Comgores B —1F&ER—FERRARBNE - EER
or . o o < — 15
P Letter format: |2000a,2000b0  v|  EjmvEE . LRGSR
Editor Lists
Editor N = —
Thde Cophaization S0l _ POy T I T ARSI T
(- Footnotes k> XMk3IM
Templates LoFISHIIA SR XS MRS A ARKEH - M~ AK N B
Field Substitutions L84 - MM A —4 + B - Ohlson (1994, 1995) - %M 2 HAZF X
Repeated Citations FNGY PHANAS BALAET Mo TRLULAL RFHALAEH
Author Lists L 2 i # 1] M(Kang and Sivaramanishoan 1995) « Zsa b 2 4 464+ 3 2
Author Neme R PO PP TP I ERRTCT Rt [T AT E
Editor Lists ) Pdc (Jonesetal 1985) « M —HFAF—F RA BB LS ELE ) 2
Editor Name i# - asbrcr _k# * Mo (Jones 19872, 1987b) -
Title Capitalization 5 2 HMAMEEINEP R P RAH - KRAN BRFABH -
=- Figures & Tables Ha 3 GAMARZERFR-FLAAHT - M KARF S 80 F oW
Figures 3¢ % ERAMAMR (FAM 1991 : B L 1992) 4
Tables B2 4 M AMBRL MK SRS RAKERTH R 6 AICPA B
Separation & Punctuation % . Cohen Commisston Report 1977) «
C Clarivate” Nes 55
HEmE" 44 %
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F.3 Citations - Author Lists ZAIFEMETRESIE B @ . ¢

About this Style

e i Author Separators
:"°""'"°"‘W°"“ Mumber of Authors between before last before last in format: Author (Year)
age Numbers
Journal Names 1 to 2 _fﬁé I.'E‘i!'
Sections
- Citations 3— to 5— . £ Ifﬁé
- Templates
- Ambiguous Citations
- Author Lists Abbreviated Author List - First Appearance=2 1/ {F & 55— 0 15
- Author Mame .
N . (7 List all author names
- Mumbering
EFi:’g gg{:ﬂwm @ If IE or more authars, list the first Il author(s)
Layout
Sort Order and abbreviate with: |ir'5'“i= Y (7| 1talic
Cat i s — —
Aiboe iy ZUFEE _RDELIR
Author Name Abbreviated Author List - Subsequent Appearances
Editor Lists
Editor Name (7 List all author names
Title Capitalization
[=- Footnotes {i-:\ If i .
s M 2 T |3 or more authaors, list the first Il author(s) %ﬁ 19']-
Field Substitutions 4 I\ =
Rapeaied Chsins =4 (AHETHER) wAERES (PX)
Author Name
Editor Lists P
Editor Nome FRERA—ROUES B2014E35 (FRHF46H ) & SIIFREZNERM &
Title Capitalization 33%&% .
~ Figures & Tabl _
T e (2 ) XPEArERES
Tables (18] fFE (ER : BR)
Separation & Punctuation (EA) BEE - ®F7E (1999 :350)
ArgyrisZSchonzE % ( 1978: 20-26)
Clarivate” Fisher ( 1978, 1985, 1999 )
© Clarivat (Z) FER=ZTAR  B—_REACESHE B RUGERHE—CEEDD SRS s

etal. (BA) ; FEBAALLE  SRENE—MESUMet al. (SA) - RO RA AL
B N R I T T R R IE—=——————————."




F.3 Citations - Author Lists ZAIFEMETRESIE B @ . ¢

- Citations
- Templates
- Ambiguous Citations P
- Author Lists Author Separators — SZII{EEE=—RX H IR
. Author Name Number of Authors between before last before last in format: Author (Year)
. Numbering 1 to |2 B and
- Sort Order
3 to 100 , & and

Abbreviated Author List - First Appearance =% {\J/E =25 W[/ 12 IR

() List all author names

(@If |3 or more authors, list the first |1 author(s)

and abbreviate with: I et al. [ ]1talic

Abbreviated Author List - Subsequent Appearances

(") List all author names

(@If |3 or more authors, list the first |1 author(s)

and abbreviate with: | etal. [ ]1talic

EndNote APASEthROutput StyleREI{EE BIRIZIRERTE
(NTU Library, 2021)
C Clarivate”

Clarivat SRS
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About this Style
Punctuation
Anonymous Works
Page Numbers
Journal Names
Sections

- Citations

- Templates

- Ambiguous Citations
. Author Lists

- Author Mame

- Mumbering

- Sort Order

Field Substitutions

Layout

Sort Order

Categories

Author Lists

Author Name

Editor Lists

Editor Name

Title Capitalization
[=- Footnotes

Templates

Field Substitutions

Repeated Citations

Author Lists

Author Name

Editor Lists

Editor Name

Title Capitalization
- Figures & Tables

Figures

Tables

Separation & Punctuation

2 Clarivate”
Blagse”

Mame Format

First author:

Other authors:

Capitalization:

Jane Smith -
John Doe b
Ag Is -

Capitalize only the authar's last name

Initials:

|L;ﬁl:l!'~lm£{ti'f

-

F.4 Citations - Author Name SIXHPEE M ZERX B ¢

Smith, Jane
Smith Jane

#ZIRLibraryFsZzEZEBMNIFERMARLTNZEIR

Mormal THEFERE

All Uppercase=® 5= S 205

Small Caps £ EAE - BREZFEEINI4E/ )\ Fie
(8 RAEEB5|BEH)

Use initials only for primary authors with the same name

Full Name
Consecutive Citations by the Same Author Last Mame Only
A. B.
Omit repeated authors (e.g. Smith 1993, 2000) A.B.
AB
Separate these dtations with: |I AR

- . TO4R
Don't omit authors from dtations that have suffives RRMERM - 215
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G.1 Bibliography - Templates

Reference Type &
Output Style=P O] &R

RYE iR} 2R R

- Layout

- Sort Crder

- Categories

- futhor Lists

- Author Mame

- Editar Lists

- Editar Mame

- Title Capitalization

Bibliography#Y
Templates 27!
RIE<S AR
HlPF A& RE

HYEER AT T

2 Clarivate”
BlaEgR”

Bill
Title, Bill-Nu
Blog
Author. (|Yeq
Book
Author.-(Yea
Book Section
Author. (Yea
Published|:P
Case
Case'Name]|,
Citation|+(|Cq
Computer Program|
Programmer
Conference Paper
Author.-(Yea
Conference Procee
Author. (|Yeq
set
=stigators
nary
hor.+(Ed.)
1 Book
or-(Ed.y
‘onic Article
hor.-(Yea
XL|-"doi’D)

Electronic Book

Author -(Yea

SRS 55| %=

-

Bibliography -
Aggregated Database

Ancient Text
Artwork.
Audiovisual Material
Bill

Blog

Book

Book Section

Case

Catalog

Chart or Table
Classical Wark
Computer Program
Conference Paper
Conference Proceedings
Dataset

Dictionary

Edited Book

Electronic Article
Electronic Book
Electronic Book Section
Encyclopedia

Equation

Figure

Film or Broadcast
Generic

Government Document
Grant

Hearing

Interview

Journal Article

Legal Rule or Regulation
Magazine Article
Manuscript

Map

Music

Mewspaper Article
Online Database
Online Multimedia
Pamphlet

Patent

-Reprint

rter-Volu
pf-Higher

rsion)

Q[T

at-the™Co

* %k K

-Trans.)|.-In-Secondary Author-(Ed.), [Eds.
Publisher|.-('Reprinted:-from:-Reprint Editi

-Place-Published|:-Publisher].
de-Volume-"Cong.-Rec.”|-Code Pages-| §-:(
of Entry|-[Description)
Editor-Ed.”Eds.| Edition-ed.|-Vol.-Volume|

| In-EditorfEd ) AEde |.Danl Titlol./ICditi

le|.-Paper-
Dataset(s)|.'Retrieved from:-URL

itle| [Translated Title]| (|Edition-ed.,-|Vols.
ion-ed.|-Vol.-Volume|)|.-Place-Published|:-

eriodical- Title,- Volume|(Issue)|, Pages|.|'R¢

priec-FA YA Fd<) [-Series Title I\l VVnlume

~Type-of Medium|:

Insert Field#%)
Templatest o] 1
ABSFIRIE D
MR K -
JNo] FHE A

presented-at-the-Conference-N

End of Paragraph
Tab

Forced Separation
Link Adjacent Text
Singular/Plural

Record Mumber
Reference Type

Authar

Year

Title

Secondary Author
Secondary Title
Place Published
Publisher
Volume

MNumber of Volumes
Number

Pages

Section

Tertiary Author
Tertiary Title
Edition

Date

Type of Wark
Subsidiary Author
Short Title
Alternate Title
ISBN/ISSM

DOI

Criginal Publication
Reprint Edition
Reviewed Item
Customn 1

Customn 2

Custom 3

Customn 4

Custom 5

Custom 6

Custom 7

Customn &

Accession Mumber

v-ed., Vol.

~r\
ry)).

her|.

hges|)|.-Place:

arallel-

m™~URL

m™-URL

|:-Publisher]|.

le-"website™:

ndars Titlel -

HEENERAT
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BREEE

- FEAPA 6t 15T #E2|BibliographyfyTemplates A

« 1#%Journal ArticleB9Journal NamefZe4 X 1IEfE - DOIE
{11 il $=2

. BER—1& - EWORDH:

)

A

C Clarivate” C
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E (R A

BN SR e Bf
BRI BB ZE1RAIRTOR - iR EZ ML -

Volume:-(Issue)

RINERE Issuetl{l - IssueBASREK - BIllZ7EHiEZLIR -

2
MEHEAIBNSEE  EPERBEZEE - BIFRAM I AEA -
Author.Title

AT IRFAuthorf@ i - Author RZEER - AT AEHIR -

2 Clarivate” RIS

Magr" RERNARA )



E{ER A

I E S —EZER KR ZEM - SS_EL EWNZERRIE -

Author.-Title.
P REINZERE XM IRAuthorfid il - FAuthorBZE{H - TitleBIAAEBZEE -

Author.--Title.
PREFE—EZE =M IRAuthort@ I - 3 _EZ=1§8II&II - FAuthorAZE
= - Titleé‘ﬂ?‘iﬁﬁ’uff*

BT SCE H
BRI EFHUBAZERBINXE - AKHHERIEA -
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End of Paragraph §
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Book
Author.-(Yea r].@
Title|-(| Translator,-Trans.-Editor-Ed. “Eds.| Edition-ed.|-Vol -Volume|)| -Place-Published|:-Publisher|.

BEridegam, M. A,, & Bridegam, M. A. (2003,
The nght to privacy. Philadelphia: Philadelphia: Chelsea House Publishers,
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Nature

wibliography Start each reference with:

SRR

emplate

Field Substitutions ‘Eiblingraphy-mumben

-

Sort Order

W/

L

1 Aberg, F. From prolonging life to prolonging working life: Tackling
unemployment among liver-transplant recipients. World journal of
gastroenterology 22, 3701-3711, doi:10.3748/wjg.v22.i14.3701 (2016).
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Citation
(Author, |Year|,"p.”pp.-Cited Pages|)
(Abd El Wahed et al., 2017)
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aFieId Names in Bibliographies

FSEXRPELIRNFS - BlFERUREERE - B
() FEIEFEAREE -

Ex FEA TS A= 000 E “Volume:” 2§ “lssue:” - SfEA8HEATNN L
"URL:" zx#EDOIRIMN L “doi”

Journal Article

Author. (Year). Title. [Translated Title]. [Reviewed Item]. Journall,-Volume|(Issue)|,-Pages|. "doi:'DOI

Emery, N. J., & Clayton, N. S. (2009). Tool use and physical cognition in birds and
mammals. Current Opinion in Neurobiology, 19(1), 27-33.
doi:10.1016/j.conb.2009.02.003

2 Clarivate”

dradivht SRS
HaEw®R REANARAD



G.2 Bibliography - Field Substitutions &I

= — Field Substitutions
Field Substitutions
ch O] #2046 = S ee4@ 38 [ If the DOI field is empty, use:
BABE - E2Z Rk |

N I-:F'.Eh'ieued+frnm-=l_.lF'.L
POl BB R A =#DOI| - [RDOIfU &8s TIRURL

Insert Field - |

F W% “ If the PMCID field is empty, use:
 Coononder [I, NIHMSID | InsertField - |
Bibliography =#EPMCID - [RPMCIDfiI &858 H3IRNIHMSID

- Templates

_ If the Volume and Pages fields are empty, use:

 Sort Order |,D0I - ] | InsertField |

~Categones =H\Volume(E)flPages(EE) - FERRHIEDOI

3 Aﬂthz:;me If the editor and translator are the same individual, use:

- Editor Lists

- Editor Name I|,-E|:|ited-and-translated-by-Series-Editnr | Insert Field - |

e Feditor(#7#8) Mtranslator(&l:%) 18 - 782438 “, edited and
translated by Editorf@ gy & "
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Start each reference with: Insert Field »

La Out?“%]éé% End of Paragraph
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S Citation
Bibliography Bibliography Mumber
- Templates Recard Number
End each reference with: Insert Field *
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- Author Lists PR
. Author Mame Tﬁ51b1¢%1ﬁ
- Editor Lists
- Editor Name

- Title Capitalization

b

%37 5445 — B4 HO 45 HERS 28, Hanging Indent: Al paragraphs |
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FRARCEEAER
HEFE—REERIEI First Paragraph only
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T?E%U 3\(}% =R, Bibliography Sort Order -

Sort Options
= \ o=t
yﬁk HF’%]“E,‘%_ E’J 12(1:}5 L Order of iiiEilnlis LIse the following controls to choose up to 5 fields as criteria
act a for custom sorting.
: L Authar + Title Sort First by this:
= ) B
@ Authaor + Year + Title :
= Then by this:
= I -
() First Author + Year + Other Authors [None ) @
A Then by this:
Bibliography () First Author + # of Authors + Year [None - &
- Templates - Then by this:
- Field Substitutions (£ Other... [ND"E '] @
Then by this:
[None =
s egores
- futhor Lists Sort Language:
- Author Mame [Systern Default v]
- Editor Lists
- Editar Mame | ok | [ Cancel ]
- Title Capitalization

Sort edited works after original works by the same author
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Author Listsd]
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Bibliography

- Templates
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- Layout
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- Author Mame
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- Title Capitalization
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Author Separators
Mumber of Authors between before last
1 to |2 ' and
3 to [100 ' , and

Abbreviated Author List

(7 List all author names

@ If I"r or more authaors, list the first Il author(s)

[~ rtalic
(") If eight or more authors, list the first 6 authors, insert: I, L

and add the last author's name

and abbreviate with: |, et al.

For Subsequent Works by the Same Authaor
@) Print the author list as defined above ~(F5% 218 - WE%E—25|H
() Omit the author list =50 E=F11

I Replace repeated authors with:  |—
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74
HEENERAT



G.6 Bibliography - Author Lists fE&BE APA 7th

About this Style Author Separators
Punctuation Number of Authors between before last
Anonymous Works |1 to I2 I‘ I' &
Page Numbers
Journal Names |3 to |100 I, I, &
Sections
- Citations
Templates
Ambiguous Citations (®) List all author names
Author Lists (@) E or more authors, list the first |1 author(s)
Author Name
Numbering and abbreviate with: |, et al. Ttalic
Sort Order . . .
& Bibliography () If eight or more authors, list the first 6 authors, insert: I. <o
Templates and add the last author's name
Field Substitutions Author Separators
Layout For Subsequent Works by the Same Author

Number of Authors between before last
Sort Order (®) Print the author list as defined above
1w |2 l &

() Omit the author list

ists () Replace repeated authors with: ~ |-— |3 to I, &

Abbreviated Author List

Editor Name

Title Capitalization
[=- Footnotes () List all author names

Templates

Field Substitutions

Repeated Citations ﬁﬁ%EﬂdNOt@%%ﬁé :

Abbreviated Author List

e If |21 or more authors, list the first {19 author(s)

and abbreviate with: |, etal. [ ttalic

Author Lists S = 4

Author Name ?%ﬂﬂﬂ?%ﬂmﬁ1§_1ﬂﬂf%

Editor Lists

Editor Name

Title Capitalization
= Figures & Tables For Subsequent Works by the Same Author
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Separation & Punctuation () Omit the author list

() Replace repeated authors with:
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. R 3 to |100 ' , and
s Abbreviated Editor List
Bibliography (7 List all editor names
- Templates
Eie'd St“b“it“““”f' @ If |4 or more editors, list the first |1 editor ()
- Layaou
- Sort Order . - — .
 Categories and abbreviate with: II et al. Italic
- Author Li P . . : :
”tr ' . () If eight or more editors, list the first 6 editors, insert: Ir L
E and add the last editor's name

- Title Capitalization
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Bibliography Initials: | A.B. -
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- Layout
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- Categories
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i Save As v ——— v Wy =8 m
File->Save as
mEdit References Groups Tools Windq | Style name: [Numbered Copy
] Open Library... Ctrl+0
Open Shared Library... Ctrtl+Shift+O — — — B —
Open Recent L4 pest
Close Style Ctrl+WW
L Save cil+¢ Title, in-Secondt
=
=] ave a Lopy... . ..
I Title|.-Edition-ec
tyle... a1y
Share... ' ﬂgai*ﬁgésave
1 A -T7 SEE
o Title, in-Book Ti >EndNotediEE
import » ;m;ﬁ""ﬂsc ' Select Another style...” ¥(ZEIF1ET
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Eh Print Preview
Print Setup... d.~eds. Title. Ec Style: Numbered Cate *  E& Categorize References =
Compressed Library (enl<) ... EI UR Numbered InStEnt Formatting is On -
) Fa Co Numbered Cate
----- Lategores Author Title. Periodical Perspect Public Manag Gov -
----- Author Lists )
Journal Article Wancouver
i Author Mame . = ippmen
.. Editor Lists Author, Title.-Journal, Y STEEES
. Editar Name Web Page
""" Title Capitalization Author. Title.-Series Titl
= Footnotes . ) .
. L Templates Available from:-URL|.
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Journal of the Chinese Medical Association

[ J Chin Med Assoc |

‘_L‘H'

JOURNAL OF THE | I

CHINESE [ N
MEDICAL

ASSOCIATION'
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10.6. References

Authors are responsible for the accuracy and completeness of their
references and for correct in-text citation.

10.6.1. In the main text, tables and figure legends
e References should be indicated by superscripted numbers according

to order of appearance in the text, and placed after punctuation.
[ The actual authors can be referred to, but the reference number(s)

must always be given. |

. erences should be compiled at the end of the manuscript accord-

ing to the order of dtation in the text.

® References should be limited to those cited in the text only.

® Journal references should include, in order, authors’ surnames and
initials, article title, abbreviated journal name, year, volume and
inclusive page numbers.

® The surnames and initials of all the authors up to 6 should be
included, but when authors number 7 or more, list the first 6
authors only followed by “et al™.

® Abbreviations for journal names should conform to those used in
MEDLINE.

* Ifciting a website, provide the author information, article title, web-
site address and the date you accessed the information.

® Reference to an article that is in press must state the joumnal name
and, if possible, the year and volume.
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Examples of the most common reference types are provided below.
(Please pay particular attention to the formatting, word capitalization,

spacing and style.)

Standard journal articles

Luo CB, Teng MM, Chang FC, Lin CJ, Guo WY, Chang CY. Stent-
assisted coil embolization of intracranial aneurysms: a single center
experience. | Chin Med Assoc 2012;75:322-8.

Huang HK, Chiang CC, Hung SH, Su YP, Chiu FY, Liu CL,

I'Ihe Irole of autologous bone graft in surgical treatment of hyper-

trophic nonunion of midshaft clavicle fractures. ] Chin Med Assoc

2012;75:216-20.
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gle-pulse TMS inclinical re search. It also in di cates
that the car diac rhythm 1s chiefly mod u lated by heart
itself.

The pathogenesis of ET still remains uncertain.
The study of pa thol ogy has not showed any ev 1 dence
of struc ture le sion in the brain/*/TMVS was able to re set
the rhythm of ET but not the heart beat. Also. the pac-
ing mech a nism was dif fer ent be tween ET and heart
beat. Positronemis sion to mogra phy of pa tients with
ET reveals increasedcerebellar activity at rest and
dur ing tremor. in di cat ing that cer e bel lum has an 1
por tant role in the gen er a tion of ET through the mech-
anism of oscillation within cerebello-olivary path-
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References

.| LownB. Verner RL Neuralac tivityand ventricularfibrilla

tion. N Engl J Med 1976;294:1165-70.

.| Lown B DeSilvaRA, Lenson R Roles of psy cho logic stress

and au to nomic ner vous sys tem changes in prov o ca tion of

ventricularpre mature complexes. Am J Cardiol 1978:41:
979-85.

_|Lavy S, Yarr I. Melamed E. Stern S. The effect of acute

stroke on cardiac func tions as ob served in an inten sive stroke
care umit. Stroke 1974:5:775-80.

.| Britton TC, Thomp son PD. Day BL. Roth well JC, Findley

LJ. Mar sden CD. Mod u la tion of pos tural wrist tremor by
mag netic stim u la tion of the mo tor cor tex 1n pa tients with
Parkin son’s dis ease or es sen t1al tremor and 1 nor mal sub-
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Huang HK, Chiang CC, Hung SH, Su YP, Chiu FY, Liu CL, et al.
The role of autologous bone graft in surgical treatment of hyper-
trophic nonunion of midshaft clavicle fractures. J Chin Med Assoc
2012;75:216-20.

Select Another Style...
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APA 6th
APA 6th-Annotated

v APA 7th
APA 7th-Annotated
Author-Date
Bluebook-Law Review
Chicago 17th Footnote
MHRA (Author-Date)
Numbered
Show All Fields
Turabian 9th Footnote

Vancouver
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Standard journal articles
Luo CB, Teng MM, Chang FC, Lin CJ, Guo WY, Chang CY. Stent- AETHMEE
assisted coil embolization of intracranial aneurysms: a single center BEEALIR
experience. ]| Chin Med Assoc2012;75
- About this Style Page Mumber Format
- Punctuation
. Anonymous Waorks (") Don't change page numbers
-| Page Mumbers (") Show only the first page number {e.g. 123)
J::uur.nal Names (") Abbreviate the last page number (e.g. 123-5)
- Sections
=- Citations (") Abbreviate the last page, keeping two digits (e.q. 123-25)
- Templates @ Show the full range of pages (e.q. 123-125)
. Ambi Citati -
m |gm.:|u5 ratens () Show only the first page for journals, full range for others
- Author Lists
- Author Name ‘
.. Numbering (") Don't change page numbers
- Sort Order (71 Show only the first page number (e.g. 123)

@ Abbreviate the last page number {(2.g. 123-5)
(") Abbreviate the last page, keeping two digits {e.g. 123-25)
{71 Show the full range of pages (e.g. 123-125)

(") Show only the first page for journals, full range for others
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Standard journal articles
Luo CB, Teng MM, Chang FC, Lin CJ, Guo WY, Chang CY. Stent-
assisted coil embolization of intracranial aneurysms: a single center

experience.| ] Chin Med Assoc

2012;75:322-8.

- About this Style
Punctuation
Anonymous Works
Page Numbers

...Journal Mames

MREESR

Tools>Open Term Lists=>Journal Term List
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Terms | Lists |
19268 Joumsls in the Joumals List:
Full Tonrmal A hbreriation 1 Abbreriation 2 _I'Iew Ve
A Pediatria Pediatria (Rio) Pediatria (Rio) _
A Trends Chuide Trends Gnide Trends Cuide Edit Term...
AM A Americen Joumsal of Dima...  AMA Lm. T Die Child. A Ay T Dis Child Delets Temm
A M 8 Archives of Dermatology . AMA Arch Deom. Syphilal. AMA ych Deom Swphilol
AM.&. Archives of Dermatology AMA Lych. Derm, AMA brch Denm Tsert Temn
A M. A, Archives of General Pewvch... AMA Arch. Gen. Pawchiatos AMA Spch Gen Pevchdatoys
A M4 Archives of Industiial Health AMA Arch. Ind. Health A4 Arch Ind Health
AM.A. Archives of Induvstis] Hvg... AMA Arch. Ind. Hvg Ocoup. bed. & AMA Srch Ind Hyg Ocoup Med
A ML Archives of Infernsl Medic .. AMA Arch. Intern. Med. AMA frch Intern Med
AM.A. Archives of Newrologyan...  AMA Arch. Neurol Pawchiatoy AMA Srch Nevro]l Pevchiatos
AM.A. Archives of Newrology AMA Lych, Newrol. AMA Srch Neuro]
A M4 Avchives of Ophthalmology  AMA Arch Ophthalmal A4 Arch Ophthalmol
AM.A. Archives of Ctolanmgology  AMA Arch. Otolarmgol. AMA bpch Ofolarmgol
A.}\{.E. Archives of Pathology AMA Axch. Pathol B340 iveh Pathi
] i
Hint: Hold the Ctod kew o slect multiple terms
" Journal Name Format Journal Mame Format
Cloz=

(7 Use full journal name
(@ Abbreviation 1
(7 Abbreviation 2
i) Abbreviation 3

() Don't replace

(7 Use full journal name
(7) Abbreviation 1

» @ Abbreviation 2
(") Abbreviation 3

(7 Don't replace
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The study of pa thol ogy has not showed any ev 1 dence JERL s B
of struc ture le sion in the bmm,lﬁlms was able tore set

Citations
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Standard journal articles
Luo CB, Teng MM, Chang FC, Lin CJ, Guo WY, Chang CY. Stent-
assisted coil embolization of intracranial aneurysms: a single center

experience| J Chin Med Assoc2012;75:322-8.
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- Punctuation

- Anonymous Waorks
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- Journal Mames
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= Citations

- Templates

- Ambiguous Citations
- Author Lists

- Author Mame

- Numbering
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- Bibliograph
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- Layout
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1. |LownB, Verrier R Neuralac tivityand ventricular fibrilla
tion. N Engl J Med 1976;294-1165-70.

2 |LownB, DeSilvaRA. Lenson R Roles of psy cho logic stress
and au to nomic ner vous svs tem changes in prov o ca tion of
ventricularpremature complexes. Am J Cardiol 1978:41:
979-83.

3 |Lavy S. Yarr I Melamed E, Stern S. The effect of acute
stroke on car diac func tions as ob served man in ten sive stroke
care unit. Srroke 1974;5:775-80.
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LJ. Mar sden CD. Mod u la tion of pos tural wrist tremor by

mag netic stim 1 la tion of the mo tor cor tex in pa tients with End of Paragraph
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and abbreviate with: |, et al [ 1talic

Huang HK, Chiang CC, Hung SH., Su YP, Chiu FY, Liu CL, et al. - o
g HA, Chiang T L NUILIAZESIE - ZH75 M
The role of autologous bone graft in surgical treatment of hyper- o ,
trophic nonunion of midshaft clavicle fractures. J Chin Med Assoc A5 Rr7sqi - #EEME
2012;75:216-20. “at al
. E'rllDlIClgrE F"h'_'p" Author Separators
Tem Flll ates Mumber of Authors between before last
to |100 k .
- Field Substitutions A el | |
{100 to 100 [ A

- Layout
Sart Order Abbreviated Author List
I:Eteg 5 ri o ® Listﬂthﬂr Hames - ﬁ.]itfreviated Author List

: i@ If IE_ or more authors, list the first IS_ author(s) © Listall author names
uthor Lists i@ If or more authors, list the firs author(s
l.:.uth::nr Mame and abbreviate with: |, etal [ ttalic o I?_ ‘ ' IE_ ©

() If eight or more authors, list the first 6 authers, insert: I .

and add the last author's name

Faor Subsequent Works by the Same Authar
(@) Print the author list as defined above
() Omit the author list

(") Replace repeated authors with:

C Clarivate” RS o
ElEMR AEAMARA S



fEEEREN

Huang HK, Chiang CC, Hung SH., Su YP, Chiu FY, Liu CL, et al. =k & =1 = Y

I <]
The role of autologous bone graft in surgical treatment of hyper- MREER - AEFEER
trophic nonunion of midshaft clavicle fractures. J Chin Med Assoc

2012:;75:216-20.
Mame Format

: E*:ib“ﬂgfﬁ phy First author: Smith Jane -
- Templates :
Field Substitutions Other authors: | Doe John -
Layout Capitalization: .Ag Is -
- Sort Order
Categories || Capitalize only the author's last name
Author Lists
Authar Mame Initials: |AE| -

C Clarivate” RIS

Magr" RERNARA )



= [UX

EH PR

- :5
= = <l

OEREH

Clarivate Formerly the IP & Science
Analytics business of Thomson Reuters

f

4

EZ

X

Yo w

HP

94



Mg - GEfZ

(—) X PR R

(#&z0] (fF& - £ B8 *5hAB . B5I XA EMEH
[ZE6I] (BB - 1964: 100-105)

(Churchland, 1995: 68-69)

(D) XPEAFEURE

(#&z0] fF&E (R BE) *5hAB . B5 | XA EMEH
[Ee6I] A M (1964: 100-105)
Churchland (1995: 68-69)

(=) EAVEMNHRBITSORERR - BHAMEE -

(#&20] RIZEARRE - LUBAGTHI SN BEEE R A
A

(3E61] Wi PhEEENITATASRENRETS -4
It was significantly higher in Germany than in the
U.S.2

h - SEXR

SEVBMERIEXZE - HiE—8 - A% - P

EUKSE SIS - SRRk F B EERE - WECHR R84S

SHHIREE - HIb - PXIRBHNZEE - ERPIIES]

A - BIh>fERT - SEEELUESRIIINRE (FERHE—RI
#Bl) - ANXSIRERP ; EREXFR5IH - BISEEER
DICTRALAFESRININER - A5 IRE MKELEE -

Clarivate
Ana|ytics business

Formerly the IP & Science
of Thomson Reuters

HR T8 U0k

&5/ :

« EXNDHPIEE - =1 BEE ) 217

- XHEBEEYR - AILUEE(FER :
B5E ) £IR

- FAMFERRERTTSOME - EZMKTIRE

DA AN B8 EERA LB

O3 RIBE :
AN PELIRNT HIEXNEERE—B

Al - P RMRES] - 2 RIRF
| &S &



— ~ HAHEw
[(#&30]
() & (1) - (B - (HHR) - & HE 8’

£

(32) Author's Name (Year). Title of the article. Title
of the Periodical, series number,

volume number: page numbers.

(#8601 8B (1973) - (EFBRREREESAZHKAVE
#r) - (EREWE) - 3,1:43-95 - (Hu,

F. (1973). Judicial Review and Judicial System in
America. EurAmerica, 3, 1: 43-95))

Dykstra, P. A. (1993).The/differential availability of
relationships and the provision and

effectiveness of support to older adults. Journal of
Social and Personal Relationships,

10, 3: 355-370.
[ZRAB]
1. EZBHIEEE 2R - LIRS ESR -
2. FEE RS BENBESIRF XX B ZEE - N
X584 (Hu, 1973) -
Clarivate

Formerly the IP & Science

Ana|ytics business of Thomson Reuters

HRFI 48 TUEESK

SIEEYR :

MR ERINER  REFRAREE
RHMERS>

Last Name, First Name (initial). Middle
Name (initial).

& EHIRE :
F—EFEFEAR - HEF/S

& 17 :

X

OEZ :
355-370

96



HAFItE TUERK
& 3ITHIESIEE R

O FEAMAR - MARNEEES] - WA "and |
R (XA TE, EE) -

OFERA=2AAE F—RAEFHESIL
F_RURERLE—(UFELM etal. (F
A) e

OFERANAMULER  8REINE—UEZLIN
etal. (X "HFA, ) -

O _IPAEFER - EX PS5 - ZEXERE
W RIHand B - IXEREIN LFEZEA
CER ) ERE - EREIMNRARZ2Z R RID R
AT e T & RER

Clarivate Formerly the IP & Science
- _ 97
Ana|yt|cs business of Thomson Reuters




HAFItE TUERK
& SERAIEFIEERA

O ZXFENG KA E—EZFREIHEER -
F_{E7F o] IEERE 1 2R A FE
( brackets ) &/~

O FEEE8 AK - AB——5hE—1FER
% - EHAie UHEER] (fFE - EN
A (XA )

Clarivate | romery the i & science
Ana'ytics business of Thomson Reuters

98



Clarivate Formerly tt
Ana|ytics business of Thomson Reuters

[FES i w3 O ]

1985: 1) "Myers 7F & IR S RIS  E R BRI S R OVER T1E
R DA A R | R T Em RS REm R R
HA SRR & | (1996: 72, 74) - Fabrice Renaud ~ Olivia Dun ~ Janos

J. Bogardi ~ Koko Warner Z A\ Z W78 B[ & #E—4F 2007 FfiS
By KEE#H 45+ (Renaud, Bogardi, Dun, & Warner, 2007: 29) » 5z

Hadaway, C. K., Elifson, K. W., & Perersen, D. M. (1984).
Religious involvement and drug use among urban
adolescents. Journal for the Scientific Study of Religion, 23,

2: 109-128.
Hayes, B. C., McAllister, 1., & Studlar, D. T. (2000). Gender,

postmaterialism and feminism in comparative perspective.
International Political Science Review, 21, 4: 425-439.

e IP & Science

99



1 _EEFAEAMEIAIED

Select Another Style...

Annotated
APA 6th
APA 6th-Annotated

v APA 7th
APA 7th-Annotated
Author-Date
Bluebook-Law Review
Chicago 17th Footnote
MHRA (Author-Date)
Numbered
Show All Fields
Turabian 9th Footnote

Vancouver

Clarivate | rormer the 1P & Science

Hayes, B. C., McAllister, 1., & Studlar, D. T. (2000). Gender,
postmaterialism and feminism in comparative perspective.
International Political Science Review, 21, 4: 425-439.

EndNote Styles

File Edit Tools Window Help

Name Category ~
[ Personnel Psychology Psycnology
[ ] Persp Psych Science Psychology
D Psychological Review Psychology
D Psychological Science Psychology
[ ] Psychology and Aging Psychology
[ | Res Organizaticnal Behavior Psychology

\ APA 6th Psychology, Multi-disciplinary

|| APA 6th Author Psychology, Multi-disciplinary
] APA 6th Copy Psychology, Multi-disciplinary
APA 6th eng Psychology, Multi-disciplinary

[ ] apa 6th H Psychology, Multi-disciplinary
[ ] aPA 6th NoDOI Psychology, Multi-disciplinary
[ ] aPaA 6th P Psychology, Multi-disciplinary
[ ]aPA 6th s Psychology, Multi-disciplinary
[ ]apa6th T Psychology, Multi-disciplinary v
Get More on the Web... Mark All Unmark All Find by »
2 | ess Info: Style Info/Preview
Morehouse SI, Tung RS. Statistical evidence for
early extinction of reptiles due to the K/T event.
Journal of Paleontology. 1993;17(2):198-209.
2. Billoski TV. Introduction to Paleontology. 6th ed.

New York: Institutional Press; 1992.

3. Schwartz MT, Billoski TV. Greenhouse hypothesis:

effect on dinosaur extinction. In: Jones BT, Lovecraft

(Wi} 1 [ . (%] L¥4 [ o [l TN

Showing 524 of 524 output styles.

~

v

®h#ECategory
HEFr B R <A
BT

BhiEStyle
Info/Preview

tNIREIFAEEL

100



2_Tools>Output Styles & Edit” FEBIl "#mIEEI0

Groups Library Window Help

Install EndNote Click Browser Extension

Output Styles 4 New Style...

Import Filters g Edit "APA 6th"
Connection Files » Edit “APA 6th eng”
Cite While You Write [CWYW] b

Format Paper 4

Subject Bibliography...
Show Connection Status

Online Search...

Clarivate
Analytics

Open Style Manager...

101



B ER1ET

Hayes, B. C., McAllister, 1., & Studlar, D. T. (2000). Gender,

postmaterialism and feminism in comparative perspective. ZENSCEE B
International Political Science Review, 21, 4: 425-439,

- About this Style Page Mumber Format
- Punctuation
. Anonymous Works (") Don't change page numbers
-+ Page Mumbers (") Show only the first page number (e.g. 123)
] | N —
::nur.na ames () Abbreviate the last page number (e.g. 123-5)
- Sections
= Citations (") Abbreviate the last page, keeping two digits (e.q. 123-25)
- Templates @ Show the full range of pages (e.q. 123-125)
. Ambiguous Citations _
9 ) () Show only the first page for journals, full range for others
- Author Lists
. Author Mame
.. Mumbering
- Sort Order
CIa rivate Formerly the IP & Science

AnalytiCS business of Thomson Reuters 102



(E LRI L

Hayes, B. C., McAllister, 1., & Studlar, D. T. (2000). Gender,

postmaterialism and feminism in comparative perspective.
International Political Science Review, 21, 4: 425-439.

- About this Style
Punctuation
Anonymous Works
Page Mumbers
E----J::uurnal Mames

Journal Name Format
@ Use full journal name
(") Abbreviation 1
(") Abbreviation 2
(") Abbreviation 3
") Don't replace

Clarivate
Analytics

Formerly the IP & Science

business of Thomson Reuters

HATI =

Library>Open Term Lists>Journal Term List

Termz | Liste
19268 Jouvmmeals in the Jowrmals List:
Full Jouel i hbrerdation 1 Abbreviation 2
£ Pediatria ed iatria (Rio) Pediatria (Fio) | ]
4 Trends Guide Trends Guide Trends Gruide Edit Term...
A M4, American Jowmal of Disea... | AMA Am. T Dis. Child. AMA A T Dis Child Delete Tomn
A M. & Archives of Demmatology . A Srch Derm. Svphilal. AbA frch Derm Syphilol
A M.4 Archives of Dermatology 8 hih Bych, Dierm, AMA Srch Derm Tnsert Temn
LM 8 Archives of General Poweh. . | AMA 8rch Gen. Pawchiatior AMA breh Gen Pavchiator
A M4, Archives of Industrial Health | AMA Arch, Ind. Health AMA frch Ind Health
AM.A Archives of Industriel Hwg,.. [ AMA Arch. Ind. Hwg. Cecup, Med.,  AkA Axch Ind Hvg Cocup Med
A8 Archives of Internal bedic . CAMA Srch Intern. bed. AbA breh Tntern bed
AM.A Archives of Hewologyran... | AMA Arch, Newrol Pevchiator AMA Srch Neurol Pevchdatos
A 4 Archives of Neuralogr bhi4 Brch Mewrnl AMA bk Nenral
A M4 Archives of Ophthalmology | AMA Arch, Ophthalmol. AMA brch Ophthalmol
A M4 Archives of Ololarmgology | AMA Arch, Otolarmgol. AMA bSrch Ofolarmgol
A W 8 Avrhives of Pathnlne 8 b4 Brch. Pathol AMA breh Pathol
[ <] il | 3
Hint: Hold the Ctrl ke to slect multiple tenms
Close




E GBS - F

(Renaud, Bogardi, Dun, & Warner, 2007: 29)

Churchland (1995: 68-69)

Citations
Templates
Ambiguous Citations
Author Lists
.. Author Mame

B I U[P|A A I Ax|=

In-Text Citations
In-Text Citation Template

| InsertField » |

(& - &0 : BE)
& (0 : BRL)

I U[P] A" A Z A

Citation
(Author, |Year| p.”pp./Cited Pages|)
Citation - Author (Year)

Author:(|Year|,-p.*pp. Cited-Pages|)

Clarivate
Analytics

Formerly the IP & Science
business of Thomson Reuters

In-Text Citations
In-Text Citation Template

|

Insert Field » |

Citation
(Author, [Year -Cited-Pages|)
Citation - Author (Year)

Author-(|Year :-Cited-Pages|)

104



S5IXIESEETER

Citations
Templates Author Separators
Ambiguous Citations Number of Authors between before last before last in format: Author (Year)
Author Lists |1 to |2 | | B | and
i Author Name

|3 to I:l":":I I, 8 I, and

Abbreviated Author List - First Appearance
(71 List all author names
@If |6 or more authors, list the first Il author(s)

and abbreviate with: | et al. Italic

Abbreviated Author List - Subsequent Appearances
(7 List all author names
i@ If |3 or more authors, list the first Il author(s)

and abbreviate with: | et al. Italic

Clarivate | romeny the 1P & Science

Ana'ytics business of Thomson Reuters 105



B RS ERT

Hayes, B. C., McAllister, 1., & Studlar, D. T. (2000). Gender, '

postmaterialism and feminism in comparative perspective.
International Political Science Review, 21, 4: 425-439.

F& (F10) - (R&) -
(A=) - &, HiEL B

- About this Style

- Punctuation

- Anonymous Works
- Page Mumbers

- Journal Mames

.. Sections

=- Citations

-- Templates

- Ambiguous Citations
. Author Lists

- Author Mame
-. Mumbering

- Sort Order

= Bibliograohy

. Templates

- Field Substitutions
- Layout

- Sort Order

- Categaries

- Author Lists

- Author Mame
- Editor Lists

C|al'i\fate Formerly the IP & Science

An alytiCS business of Thomson Reuters

Bibliography
[ Reference Typesk ] [ Insert Figld »
Government Document a

Author.-(Year). Title..(Report:-Number).-Place Published]:
-Publisher|-"Retrieved-from™URL].

Hearing
Title, Legislative Body, Session-"Sess’|.-Pages|-(Year)|-(History)|.
Interview

Interviewee. (Year|,-Date|) Title|/ Interviewer: -Interviewer|.-|Program:|

(VoI *Number)|,-Publisher|,-Place-Published].

Journal Article

Author.-(Year). Title. [Translated Title].- [Reviewed Item]. Journal|,
‘Volume|(Issue)| -Pages|. "doi:"DOI

Legal Rule or Regulation

Title, Rule-Number-C.F.R.|-§-Section-Number|-(Year)|,-History].

Magazine Article
Author. (Yearl-Datell.-Titlel-Maaazinel.-Volumel.-Paaesl.

g

Journal Article
Author.-(Year). Title. Journall|,-Volume|,-Issuel|:-Pages].

106



FEERE

Hayes, B. C., McAllister, I., & Studlar, D. T. (2000). Gender,
postmaterialism and feminism in comparative perspective.
International Political Science Review, 21, 4: 425-439.

Mame Format

.Bibliography

First authar: Smith, Jane -
- Templates
. Field Substitutions Other authors: | Doe, John hd
- Layout Capitalization: |AsIs -
----- Sort Order
. Capitalize only the author's last name
... Categories
.. Author Lists Initials:
.| Author Mame Full Name

Last Mame Dnli

A.B.

AB

AE

Clarivate Formerly the IP & Science
Ana|ytics business of Thomson Reuters

108



M RMEREAR/NE

Hayes, B. C., McAllister, 1., & Studlar, D. T. (2000). Gender,
postmaterialism and feminism in comparative perspective.

International Political Science Review, 21, 4: 425-439.

E| Bibliography
- Templates
. Field Substitutions

Title Capitalization

Categories '@ Leave titles as entered
. Author Lists
Author Mame
. Editor Lists ) Sentence style capitalization
Editor Mame

.| Title Capitalization

(71 Headline style capitalization

Clarivate | | ormerly the IP & Science
Ana|ytics business of Thomson Reuters

F—EFEFHBAE -
HER/ NS

Title Capitalization
() Leave titles as entered
(") Headline style capitalization

@ Sentence style capitalization

109



BIDE | BITEL

Groups Library Window Help

Install EndNote Click Browser Extension

Output Styles ».  New Style...

Import Filters » Edit "Amer J Public Health"

N Edit "APA 7th"

Connection Files

. . Untitled Style
Cite While You \\j i
File Edit Tools Window Help

Format Paper
Plain Font Plain Size ‘ ‘ ‘

Subject Bibliogra ?Essttu?tl‘so ity\e 2
Show Connectior -Anonymous Works Full ame: |
~Page Numbers Based on: |
. ~Journal Names
Online Search... | sections Category: |
=+ Citations Publisher: |
- Templates URL: |
~Ambiguous Citations
- Author Lists Created:
- Author Name Last modified:
EU:’ISEQHQ Comments and limitations:
~Sort Order
= Bibliography
Templates
- Field Substitutions
- Layout
Sort Order
- Categories
kvi 1= TN 2 = 4AA T YN ~Author Lists o
THIFEEBNVEERE | oo

vancouver

C Clarivate”

5 - 111
Hau® HEAABRAT



EE&ENHRAFR



